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Essentials

. Assign Pay Items with FDOT Entity
Manager

2. Open Autodesk QTO Manager and

verify Pay Item database is loaded.

3. Launch QTO Takeoff Reports

QTO pay item rules:

QTO Takeoffs can read the following pay items:

» Pay Items in the active file assigned to
AutoCAD entities and Civil 3D objects

» Pay ltems assigned to AutoCAD and C3D
entities in a XREF.

NOTES:

oData References with Pay Items assigned to source
geometry will only list the type. (no quantity)

oData References cannot be assigned directly pay
items
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WORKING WITH FILES

*Use External References
*Data reference in Alignment
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Pay item summary from
Trns*port

Create CESSFile

Launch FDOT TRNS*port Utility
from Ribbon

Browse to Folder containing sample
Choose Layout Tab

Delete Extra Layout Tabs

Save Drawing

Open FDOT.DST

Import Summary Sheet Layout
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FDOT Quantity Takeoff

FDOT State Kit for AutoCAD Civil 3D 2012
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Workflow:

Step 1: Assign Pay Items with Entity Manager

Step 2: Launch QTO Manager
Load FDOT Pay Item database and categorization file.

rﬂ, Open Pay Item File = @ﬁ

Pay item file format:
| Florida DOT -

Pay item file:
. C30\Data'Pay Item Data\AECMERGE. XML

Pay item categorization file:
\Data'\Pay Item Data'FloridaCategories, xml

[ Advanced Cptions ]

[ QK H Cancel ][ Help ]

Step 3: Run Quantity Take Off Report
Ribbon Analyze tab > QTO panel > Takeoff

YLK GG -] AutoCAD Civil 302012 CLIPRDOL.dwg [22807915201-C3D] Type 2 keyword or pira

Home Insert  Annotate  Modify m View Output Manage Help Online Add-Ins  Express Tools o -
ﬁ (V] @ Contour Check @ 3 @ Edit in Storm Sewers ﬁE Volume Report Compute Materials
‘ =
_/ 6* Flow Paths = X \/ ﬁ Edit in Storm and Sanitary Analysis X E Total Volurme Table Dé Mass Haul e
Survey  Quick Visibility  Interference Volumes  Grading Volume QTO Manager | Takeoff
T Profile @ Catchments - Check Check T Tools E Material Volume Table
Ground Data = | Design = | Volumes and Materials | QTo

The Compute Takeoff Dialog is used to define the report type, extents, and output content to be included in the
quantity takeoff report.

e The Report Type needs to be set to Detailed.

e The Report Extents will be set to Drawing so that all the information in the drawing is included.

e Limit extents to alignment station range needs to be checked. This will allow the user to limit the
area that Takeoff will be evaluating.

e Select the Alignment used for the Takeoff process. This is typically the Main alignment of the
drawing.

e The Beginning and Ending stationing can be typed in or can be selected using the button on the
right.



e The Report Output will need to select the Alignment so that the information is relative to that
alignment. The station and offset will be included in the report.

Select the Compute button to create the report.

|| Report selected pay items only ]

Report station and offset relative to: -

e .
< - 1B
_—l—l-'-'-'-II
( | Compute )| Close | | Help )
2

"N..._,__‘____.___,_...-"




Step 4: Format FDOT Style Sheet

The quantity takeoff report is displayed in a default XML format and needs to be styled using an FDOT style
sheet.

"% Quantity Takeoff Report =10 %]

=?xml version="1.0" encoding="UTF-8" 7=
- <inf:InfrastructureProject xmins:gml="http:/ /www.opengis.net/gml"
xmins: tkdp="http:/ fwww.transxml.net/schema/dp/0.3"
xmins: ter="http:/ fwww.transxml.net/schema/ref/0.3"
xmins: txl="http:/ /fwww.transxml.net/schema /il /0.3"
xmins:c3d="Civil2D.QTO.Computation" xmlns:msxsl="urn:schemas-
microsoft-com:xslt" e
xmins:inf="http:/ /www.aecxml.org/schemas/infra/v33-
20020509"
xmins:aec="http:/ /www.aecxml.org/schemas/CO0S/vo0b-
20001002" xmins:xsi="http:/ fwww.w3.org/ 2001 /XMLSchema-
instance">
- =ProjectOverview >
<aec:ProjectName =design project</asc:ProjectName:
<aec:ProjectMumber /=
<aec:Description>ID001 </aec:Description>
=/ProjectOverview =
=DefaultUnitSystem=ENGLISH </DefaultUnitSystem=
=SpecBookVersion=07 </SpecBookVersion= _|;|
3

1 |

ITransPnrtDesignInterFace.xsl j | Diraw I Save As, ., Close | Help |

Navigate to the folder with all the FDOT style sheets and select the appropriate tabulation style sheet.
Tabulation Spread sheets are found in the FDOT2012.C3D\Data\QTO Reports\Style Sheets.

Select the style sheet that corresponds to the Pay Items that you selected previously.



L= Choose style sheet

Loak jm: I@ Florida Dot

X

j @(ﬁxﬁ YWiews + Toolz -

] Mame = Size | Type | Date Mn:u:IiFiediI
ﬁ +2 | Florida700-050-09 Linear with. .. G KB %5l Skyleshest 5l21/2010 11;
+ | Florida700-050-10 Pay Ttem 5... 3KB  ®5L Skvlesheet gl21/2010 11;
| sharedLibs.xsl 11 KB ®5L Styleshest 3172010 35
‘ 4 Tabulation-64% Poles,xsl G kE 5l Styleshest Sl21jz01011;
A Tabulation-110 Mailboxes. xsl G kKE 5L Styleshest Si21jz010 11
ty Documents # Tabulation-430-17 Side Drain. .. G kKE  ®5L Styleshest Siz1jz01011;
4 Tabulation-430-93 Mitered En. .. A KE 5L Styleshest Si21)z010 11
+| Tabulation-440 Underdrainita, .. A KE 5L Skyleshest Sl21jz010 11,
+&| Tabulation-536 GuardRail(toE. .. 6 KB ®5L Skvlesheet 5l21/2010 11;
+ | Tabulation-546 Hand Ruail{toE. .. 6 KB ®5L Skvlesheet gl21/2010 11:
+& | Tabulation-548 Gravity Wallt, .. 6EE %3l Styleshest gl21/2010 11;
Tabulation-550 FenceltoExcel, . 6 KB %5l Skyleshest gl21/2010 11;
+E Tabulation-575 Perfarmance .., G kE 5l Styleshest Sl21jz010 11,

A TransPortDesigninterface, xsl SkKE ®5L Styleshest 372010 3:5:

0 | TN

il meme ITaI:quatiu:un-EEEl FenceltoE xcel]. =zl j Open |j

j Cancel |

Files of tpe: I " sl

The tabulation style sheet will create a different XML file which will need to be saved into the project folder

structure.

x
Save jr: I@data j =) @ ¥ Fi views v Tooks -

| Date Madified
8152010 2:03 F

Size I Type
ZKE =ML Document

Mame =~ I
| TransPortDesignInterface.xml

a 0

j Save |
j Cancel |

T abulation-550 Fencelto

File name:

Files of typez | "=ml




Step 5: Open the FDOT Excel Template

Load Excel, and open the FDOT Excel template file that corresponds to the previously created tabulation style

sheet.

FDOT Excel templates are found in the FDOT2012.C3D\Data\QTO Reports\Excel Sheets.

v Computer » Local Disk (&) » FDOT2012.C3D » Data

€10

File Edit View Tools Help
Organize ~ II\_=;|!JOF:|EI'| - E-mail MNew folder
-
» 0 Favorites
» |l Libraries

f-& Homegroup

m

4 8 Computer
> &, Local Disk (C:)
*—a Local Disk (D:)
> 58 Apollo-User (AMSAANDSYMANTEC) (G:)
- # Saturn-Appshare (Vmsaandsymantec) (L)
» L@ Saturn-User (\\msaandsymantec) ()
- L Saturn-Download (Vmsaandsymantec) (K:)
» L@ Apollo-DB (Vwmsaandsymantec) (L:)
- L8 Saturn-Images (\msaandsymantec) (M:)
» L8 Saturn-MakeDisk (\\msaandsymantec) (P:)

Tabulation-Fence.xlsx Title: Add a title
Microsoft Office Excel 2007 Workbook Authors: Add an author

LVJ

1 item selected

- 8 Apollo-Apps (\\msaandsymantec) (T:) S

» QTO Reports » Excel Sheets

MName

‘l?‘i] Florida700-050-01 Area Computations.xlsx
E51] Florida700-050-02 Curb and Gutter Com...

‘l?‘i] Florida700-050-03 Linear-Weight-Hour-D...

E31] Florida700-050-04 Volume Measure.xdsx
F‘i] Florida700-050-05 LumpSum (tobxcel)sxdsx

‘F‘i] Florida700-050-06 Weight Measure or Lig...

F‘i] Florida700-050-10 Pay Itern Summary.xlsx
‘l?‘i] Tabulation-Fence.xlsx

B P2 nolnon
"

[

010 5:38 PM
3/2010 2:48 PM

Micr

‘l?‘i]TabuIat\on-Gravit_\,rWaII-AIuminumHan
‘l?‘i]Tabulat\on-GuardraiI.xst
‘l?‘i]Tabulat\on-MaiIboxes.xlm

Type: Microsoft Office Excel 2007 Workbook |
Size: 38.1 KB
Date modified: 5/13/2010 2:48 PM

‘l?‘i] Tabulation-PerformanceTurf xlsx
] Tabulation-Polealsx

Ill?‘i]Tabulat\orrSit:Iet:Irain and MiteredEndSec...

E5] Tabulation-Underdrain.dsx

Size: 381 KB
Date modified: 5/13/2010 2:48 PM

3/17/2010 5:40 PM
3/12/201011:24 AM
3/24/2010 8:32 AM
3

f24/2010 8:32 AM

Tags: Add atag

Microsoft Office E...
soft Office E...
Microsoft Office E...
Microsoft Office E...

Mic

soft Office E...
rosoft Office E...
soft Office E...
rosoft Office E...
soft Office E...
Microsoft Office E...
soft Office E...
Microsoft Office E...

Size

W& Computer

Microsoft Excel - XI0000001.xls [Read-COnly]
B Ele Edit View Insert
DEeEdan &R_RY & 2R v

B8 - A =RAW DatalP11

Format Tools Data

Window

Help

B = -2 R 4 75

Arial

L

Type a question for help

=8 EoR ==

- - 8 X

A B [ ¢ D E

SUMMARY OF FENCING TYPE A

FENCE

LOCATION TVEE £,

CORMERPOST
ASSEMELY

PULL &END
POST ASSEM.

SIDE
STa. TOSTA. T

EA

B

= F

= F

FEMARKS

FIELD BOOK
REFEREMCE

u:|i-.1mu1.p.|.u P e
-

7 TOTAL:

W 4 » M| Type A Type B/ No Post / RAW Data /
Ready

MNUM




Make sure the Developer Tab is Displayed.

Excel Options

E-mail
Quick Print
Print Preview
Spelling & Grammar
Undo

Formulas
Praofing
Save
Advanced
Customize
Add-Ins
Trust Center

Resources

e ¥ W

Redo
Draw Table

‘More Commands...
Top options for working with Exc Show Below the Ribbon

Mipimize the Ribbon

ScreenTip style: |Show feature descriptions in ScreenTips

Create lists for use in sorts and fill sequences: Edit Custom Lists...

When creating new workbooks

Use this font:




Step 6: Import Quantity Takeoff XML Data
Go to the Raw Data tab and clear any data from the form so that the XML file can be imported into the new file.

s "

o) =H Y- s Microsoft Excel T - B X
.!- Lﬂ‘ e —
Home Insert g Cut ' |Deuelnper| Design @'
|_|_ I— _—
L
= B ()
L 1= cha £ el Export :
Wisual Macros I ‘-ﬂ' Faste Drocument
Basic A Paste Special... Panel
Code | lﬂ Refresh Modify | |
Tabled Insert R *
& Tabulation-Fence x| Delete > - = -
AL B Select g E 8 i
: |
z [ Clear Contents [
3
4 Sort 3
5 Filter 3
B
7 Table »
& HML k =
3

:timatedﬂuantilﬂ unitDfMeasur

29024 LF

23024 LF

29084 LF

lumpSunfg| i I.J Insert Comment

| 5| Farmat Cells...

Fick From Drop-down List...

Hyperlink...

Next, Import XML file by going to the Developer tab in Microsoft Excel 2007, then select Import.

Navigate to the XML file created earlier. This will Import all the data from the XML file into the spreadsheet with
the correct headings for the data.



Microsoft Excel

view View Developer
E‘ E- Map Properties ||=_'ﬁ1mport|
Li e : = d0
& Expansion Packs 2 Export
Source @ Document
J -ERefresh Data Panel
| XML || Modify

Import XML Data

Import an XML data file.

E F [E] H o

Import XML
Laoak in: |EJ data V| @ -0 X Ci E3-

@ My Recent Tabulation-550 FenceltoExcel), xml
Documents || = TransPortDesignInterface.xml

@ Deskkop
i

Docurments

Cormnpuker
‘:i My Mebwork
Places

File narne: | " |

Files of Lype: L Files (* ) v|

g [ cows

Go to a Type tab and click on the first line of data and then pull it down to see all the other lines of data. You will
also see totals at the bottom as well.



Click Save to save Excel data file at the top of Excel.

-'f-_;a\\, = = - s Microsaft Excel - = X
W Iiad
—Fj Home Insert Page Layout Farmulas Data Review Wiew Developer | &)
7 = = |\i_l > & E % Map Properties Bl Import e‘ﬁ
=l = iz % - (o <.{E,'jExpar1sic|r1 Packs tﬂExport (=t
Wisual Macros Insert D n Souree o, Document
Basic P 1) - Mode H #¢ Refresh Data Panel
Code Controls XML Modify
| B8 - f | =RAW Data'lP11
2] Tabulation-Fencexlsx [Read-Only] - =2 X
-] E [ e} E F [t} H | i |3
1
Z
] SUMWMARY OF FENMCING TvPE A
5 LOGATION a0 Trrea aEriELT P;I-;I;'Lazis’éfd. HEMARKS FIELD BO0K
-?‘ STA.TOSTA. = IFT - = E& - = E& - REFEREHCE
Ed [TE+ ko TEF TR, [ FT_| TT.0
) |7z o TE+T1. L .4
0] |73+75.914a T3+75, Fi 263
11 |73+ ko Td+i0. F’ 1Z.6
1z 7441077 ka Td+11.20 L 22.1 A |
1z |73+ 76.92 o T+AT.T3 Fi 2d. % =
1d [TE+T1E4en Td+10.77 L 55.4i
15
hL3
17
1%
19
Zi
4 |
Zz
23
zd
25
6
T TOTAL: 2905
44+ ¥| Type A ~Type B~ No Post .~ RawW Data [l m
Average: 41,.54857143  Count: 21 Sum: 29054 u@lﬁl 51% E;!—@—'is;! i

Step 7: - Excel file Configuration

Make sure in the View tab that you uncheck Grid Lines.

- ’ B N q
( ng\l = Mlicrosoft Excel - = X
Home Insert Page Layout Farmulas Data Review View Developer 'Q)
Ell= = (RN ==
_|J =20
Mormal| Page Show/Hide  Zoom | Window | Macros
Layout B S - ~
Workbook Views Macros
BS Ruler ¥| Farmula Bar [5'lp11
- . [ Gridlines V| Headings 1
&3] Tabulation-Fenct - = X
- e Message Bar J " , R « ,i
; — Show/Hide
z View Gridlines
5 LOGATION — FIELD EQOK
5 J— Show the lines between rows and FEFERENCE
; TR 1 3 columns in the sheet to make
9 | [Tevessernvseiiza | editing and reading easier.
10 [73+75. 910 T3475.91 2
bl T3 +97. T3 k0 Td+10.52
1 | [FdeieTrenTAeilan ‘ These lines will not print unless i |
12 [P3+76.92 b 7349772 H H =
= ’%‘_29:“?4“ L Print is also checked.
| [ 1 3
16
il 2 4
1%
14
&l
21 —
z %)) Press F1 for more help.
23
24
&5
2k ..
T TOTAL: 2403 4|
4 4 M| Type A Type B NoPost .~ RAW Data [ m
Average: 41.54857143  Count: 21 Sum: 20034 |(EH [OI [l s1se (=)0 (%)

10



Step 8: Copy Table
Now highlight the table then right-click and select Copy.

!./mg = s Microsoft Excel - = X
- Home Insert Page Layout Formulas Data Review View Ceveloper '@]
BN Y ] =
1= =
Mormal| Page Show/Hide | Zoom | Window | Macros
Layout o = - o
Waorkbook Views & | Cut
Print_Area 3 Copy
o . [y | Paste ]
|I\ﬁTabLlIatlon-Fence.ljs - =3 X

Paste Special...

A E J K

1

z Insert...

: Delet

4 Delete...

5 BRI L REMARKS FIELD EQOK
: ST ToSTA. Clear Contents — REFERENCE
] G957 o T34 7692 .

3 5% ko T3AT1ES Filter b

10 ETtp TE+T5.1

1 T3 ko TA+10.32

12| [TE0.TTee TArLEY Sart b 1
1% EB‘ %92 ko TI4T.TS =4
1| [TETiEde TAIRTT A Insert Comment

15

16 i

i % Format Cells...

1%

18 Pick From Drop-down List...

i

B -

= Mame a Range...

25 .

24 % Hyperlink...

25

26 | | | | | | |

Bl THTAL: | | IIEE 1 | 1 1

M < b M| Type A, Type B . No Post -~ RAW Data || m

Average: 44.74461538  Count: 50 Sum: 58168 UE@ 51% E;E—G—-—g;; K

Step 10: Paste Table in Paperspace

Open up Civil 3D. Create Summary of Quantities Drawing.

Select 1:1 Scale Layout Tab

sTaTE o FLOAISE

DESLATMENT OF T ARNSS0STATION -
— — — 1 BCALE

| L I

/ 80Scale / 100Scale / 200 Scale / 500 Scale / 1

Right-click in Papespace and Paste into Paper space by selecting Clipboard and then Paste.

11



Repeat U

Recent Input 4
Isolake Chiects 4
Clipboard 3 cut Chrl
[ ca Chr+C
Biasic Modify Tools * '_—D =oP¥
Display Ord > 0O, Copy with Base Paint ChrH-Shift-+C
Display Order =
T
AFC Modify Tools * 5al Paste as Black
{'? Pan ,m Faste ba Original Coordinates
@Q Zoom
L5 Free Orbit

ﬁ" Quick Select..,
FES Find,,.

Options. ..

wh

iand: _u PasteCtrl+V GROUP
sand:

sand

A line where the bottom of the table will be displayed so make sure you place it near the bottom of the page so
that it will fit correctly. The Font, Point Size and actual Text Height can be changed in the display before it is
pasted in the file. The default is preferred.

SUmtdaRY OF FEMHCING TvPE A

 Command: pasteclip
Specify insertion point:

Corostd

| e+ [ L 1= [+ [+] s [l

[l

12



FDOT Quantity Takeoff

FDOT State Kit for AutoCAD Civil 3D 2012

Mary Ann Peterman

Florida Department of Transportation
Mary.peterman@dot.state.fl.us
850-245-1623

ENGINEERING/CADD
SYSTEMS OFFICE

& ECSO




Workflow:

Step 1: Assign Pay Items with Entity Manager

Step 2: Launch QTO Manager
Load FDOT Pay Item database and categorization file.

rﬂ, Open Pay Item File = @ﬁ

Pay item file format:
| Florida DOT -

Pay item file:
. C30\Data'Pay Item Data\AECMERGE. XML

Pay item categorization file:
\Data'\Pay Item Data'FloridaCategories, xml

[ Advanced Cptions ]

[ QK H Cancel ][ Help ]

Step 3: Run Quantity Take Off Report
Ribbon Analyze tab > QTO panel > Takeoff

YLK GG -] AutoCAD Civil 302012 CLIPRDOL.dwg [22807915201-C3D] Type 2 keyword or pira

Home Insert  Annotate  Modify m View Output Manage Help Online Add-Ins  Express Tools o -
ﬁ (V] @ Contour Check @ 3 @ Edit in Storm Sewers ﬁE Volume Report Compute Materials
‘ =
_/ 6* Flow Paths = X \/ ﬁ Edit in Storm and Sanitary Analysis X E Total Volurme Table Dé Mass Haul e
Survey  Quick Visibility  Interference Volumes  Grading Volume QTO Manager | Takeoff
T Profile @ Catchments - Check Check T Tools E Material Volume Table
Ground Data = | Design = | Volumes and Materials | QTo

The Compute Takeoff Dialog is used to define the report type, extents, and output content to be included in the
quantity takeoff report.

e The Report Type needs to be set to Detailed.

e The Report Extents will be set to Drawing so that all the information in the drawing is included.

e Limit extents to alignment station range needs to be checked. This will allow the user to limit the
area that Takeoff will be evaluating.

e Select the Alignment used for the Takeoff process. This is typically the Main alignment of the
drawing.

e The Beginning and Ending stationing can be typed in or can be selected using the button on the
right.



e The Report Output will need to select the Alignment so that the information is relative to that
alignment. The station and offset will be included in the report.

Select the Compute button to create the report.

|| Report selected pay items only ]

Report station and offset relative to: -

e .
< - 1B
_—l—l-'-'-'-II
( | Compute )| Close | | Help )
2

"N..._,__‘____.___,_...-"




Step 4: Format FDOT Style Sheet

The quantity takeoff report is displayed in a default XML format and needs to be styled using an FDOT style
sheet.

"% Quantity Takeoff Report =10 %]

=?xml version="1.0" encoding="UTF-8" 7=
- <inf:InfrastructureProject xmins:gml="http:/ /www.opengis.net/gml"
xmins: tkdp="http:/ fwww.transxml.net/schema/dp/0.3"
xmins: ter="http:/ fwww.transxml.net/schema/ref/0.3"
xmins: txl="http:/ /fwww.transxml.net/schema /il /0.3"
xmins:c3d="Civil2D.QTO.Computation" xmlns:msxsl="urn:schemas-
microsoft-com:xslt" e
xmins:inf="http:/ /www.aecxml.org/schemas/infra/v33-
20020509"
xmins:aec="http:/ /www.aecxml.org/schemas/CO0S/vo0b-
20001002" xmins:xsi="http:/ fwww.w3.org/ 2001 /XMLSchema-
instance">
- =ProjectOverview >
<aec:ProjectName =design project</asc:ProjectName:
<aec:ProjectMumber /=
<aec:Description>ID001 </aec:Description>
=/ProjectOverview =
=DefaultUnitSystem=ENGLISH </DefaultUnitSystem=
=SpecBookVersion=07 </SpecBookVersion= _|;|
3

1 |

ITransPnrtDesignInterFace.xsl j | Diraw I Save As, ., Close | Help |

Navigate to the folder with all the FDOT style sheets and select the appropriate tabulation style sheet.
Tabulation Spread sheets are found in the FDOT2012.C3D\Data\QTO Reports\Style Sheets.

Select the style sheet that corresponds to the Pay Items that you selected previously.



L= Choose style sheet

Loak jm: I@ Florida Dot

X

j @(ﬁxﬁ YWiews + Toolz -

] Mame = Size | Type | Date Mn:u:IiFiediI
ﬁ +2 | Florida700-050-09 Linear with. .. G KB %5l Skyleshest 5l21/2010 11;
+ | Florida700-050-10 Pay Ttem 5... 3KB  ®5L Skvlesheet gl21/2010 11;
| sharedLibs.xsl 11 KB ®5L Styleshest 3172010 35
‘ 4 Tabulation-64% Poles,xsl G kE 5l Styleshest Sl21jz01011;
A Tabulation-110 Mailboxes. xsl G kKE 5L Styleshest Si21jz010 11
ty Documents # Tabulation-430-17 Side Drain. .. G kKE  ®5L Styleshest Siz1jz01011;
4 Tabulation-430-93 Mitered En. .. A KE 5L Styleshest Si21)z010 11
+| Tabulation-440 Underdrainita, .. A KE 5L Skyleshest Sl21jz010 11,
+&| Tabulation-536 GuardRail(toE. .. 6 KB ®5L Skvlesheet 5l21/2010 11;
+ | Tabulation-546 Hand Ruail{toE. .. 6 KB ®5L Skvlesheet gl21/2010 11:
+& | Tabulation-548 Gravity Wallt, .. 6EE %3l Styleshest gl21/2010 11;
Tabulation-550 FenceltoExcel, . 6 KB %5l Skyleshest gl21/2010 11;
+E Tabulation-575 Perfarmance .., G kE 5l Styleshest Sl21jz010 11,

A TransPortDesigninterface, xsl SkKE ®5L Styleshest 372010 3:5:

0 | TN

il meme ITaI:quatiu:un-EEEl FenceltoE xcel]. =zl j Open |j

j Cancel |

Files of tpe: I " sl

The tabulation style sheet will create a different XML file which will need to be saved into the project folder

structure.

x
Save jr: I@data j =) @ ¥ Fi views v Tooks -

| Date Madified
8152010 2:03 F

Size I Type
ZKE =ML Document

Mame =~ I
| TransPortDesignInterface.xml

a 0

j Save |
j Cancel |

T abulation-550 Fencelto

File name:

Files of typez | "=ml




Step 5: Open the FDOT Excel Template

Load Excel, and open the FDOT Excel template file that corresponds to the previously created tabulation style

sheet.

FDOT Excel templates are found in the FDOT2012.C3D\Data\QTO Reports\Excel Sheets.

v Computer » Local Disk (&) » FDOT2012.C3D » Data

€10

File Edit View Tools Help
Organize ~ II\_=;|!JOF:|EI'| - E-mail MNew folder
-
» 0 Favorites
» |l Libraries

f-& Homegroup

m

4 8 Computer
> &, Local Disk (C:)
*—a Local Disk (D:)
> 58 Apollo-User (AMSAANDSYMANTEC) (G:)
- # Saturn-Appshare (Vmsaandsymantec) (L)
» L@ Saturn-User (\\msaandsymantec) ()
- L Saturn-Download (Vmsaandsymantec) (K:)
» L@ Apollo-DB (Vwmsaandsymantec) (L:)
- L8 Saturn-Images (\msaandsymantec) (M:)
» L8 Saturn-MakeDisk (\\msaandsymantec) (P:)

Tabulation-Fence.xlsx Title: Add a title
Microsoft Office Excel 2007 Workbook Authors: Add an author

LVJ

1 item selected

- 8 Apollo-Apps (\\msaandsymantec) (T:) S

» QTO Reports » Excel Sheets

MName

‘l?‘i] Florida700-050-01 Area Computations.xlsx
E51] Florida700-050-02 Curb and Gutter Com...

‘l?‘i] Florida700-050-03 Linear-Weight-Hour-D...

E31] Florida700-050-04 Volume Measure.xdsx
F‘i] Florida700-050-05 LumpSum (tobxcel)sxdsx

‘F‘i] Florida700-050-06 Weight Measure or Lig...

F‘i] Florida700-050-10 Pay Itern Summary.xlsx
‘l?‘i] Tabulation-Fence.xlsx

B P2 nolnon
"

[

010 5:38 PM
3/2010 2:48 PM

Micr

‘l?‘i]TabuIat\on-Gravit_\,rWaII-AIuminumHan
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Make sure the Developer Tab is Displayed.

Excel Options

E-mail
Quick Print
Print Preview
Spelling & Grammar
Undo

Formulas
Praofing
Save
Advanced
Customize
Add-Ins
Trust Center

Resources

e ¥ W

Redo
Draw Table

‘More Commands...
Top options for working with Exc Show Below the Ribbon

Mipimize the Ribbon

ScreenTip style: |Show feature descriptions in ScreenTips

Create lists for use in sorts and fill sequences: Edit Custom Lists...

When creating new workbooks

Use this font:




Step 6: Import Quantity Takeoff XML Data
Go to the Raw Data tab and clear any data from the form so that the XML file can be imported into the new file.
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Home Insert g Cut ' |Deuelnper| Design @'
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L
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Code | lﬂ Refresh Modify | |
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z [ Clear Contents [
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4 Sort 3
5 Filter 3
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lumpSunfg| i I.J Insert Comment

| 5| Farmat Cells...

Fick From Drop-down List...

Hyperlink...

Next, Import XML file by going to the Developer tab in Microsoft Excel 2007, then select Import.

Navigate to the XML file created earlier. This will Import all the data from the XML file into the spreadsheet with
the correct headings for the data.



Microsoft Excel

view View Developer
E‘ E- Map Properties ||=_'ﬁ1mport|
Li e : = d0
& Expansion Packs 2 Export
Source @ Document
J -ERefresh Data Panel
| XML || Modify

Import XML Data

Import an XML data file.
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Files of Lype: L Files (* ) v|
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Go to a Type tab and click on the first line of data and then pull it down to see all the other lines of data. You will
also see totals at the bottom as well.



Click Save to save Excel data file at the top of Excel.
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Step 7: - Excel file Configuration

Make sure in the View tab that you uncheck Grid Lines.
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Step 8: Copy Table
Now highlight the table then right-click and select Copy.

!./mg = s Microsoft Excel - = X
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Step 10: Paste Table in Paperspace

Open up Civil 3D. Create Summary of Quantities Drawing.

Select 1:1 Scale Layout Tab

sTaTE o FLOAISE

DESLATMENT OF T ARNSS0STATION -
— — — 1 BCALE

| L I

/ 80Scale / 100Scale / 200 Scale / 500 Scale / 1

Right-click in Papespace and Paste into Paper space by selecting Clipboard and then Paste.
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Repeat U

Recent Input 4
Isolake Chiects 4
Clipboard 3 cut Chrl
[ ca Chr+C
Biasic Modify Tools * '_—D =oP¥
Display Ord > 0O, Copy with Base Paint ChrH-Shift-+C
Display Order =
T
AFC Modify Tools * 5al Paste as Black
{'? Pan ,m Faste ba Original Coordinates
@Q Zoom
L5 Free Orbit

ﬁ" Quick Select..,
FES Find,,.

Options. ..

wh

iand: _u PasteCtrl+V GROUP
sand:

sand

A line where the bottom of the table will be displayed so make sure you place it near the bottom of the page so
that it will fit correctly. The Font, Point Size and actual Text Height can be changed in the display before it is
pasted in the file. The default is preferred.

SUmtdaRY OF FEMHCING TvPE A

 Command: pasteclip
Specify insertion point:

Corostd

| e+ [ L 1= [+ [+] s [l

[l
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